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Inledning 1

Vad innehåller det här kapitlet?
• Översikt: sida 1

• Hjälp: sida 3

• Kompatibla enheter: sida 3 

• Att använda bruksanvisningen: sida 6

• Användarsäkerhet: sida 6

Översikt   

Tack för att du valt Medtronic Diabetes som din partner för att 

underlätta för dig och dina patienter att styra diabetesbehandlingen. 

Vi tror att du kan ha nytta av CareLink™ Pro-programmets banbrytande 

teknik och enkla, menystyrda användargränssnitt.

I bruksanvisningen beskrivs hur man ska använda CareLink Pro för att 

ta fram, lagra och rapportera om patienternas behandling och 

diagnostiska uppgifter. Den beskriver också hur man når glukosdata 

från pump, mätare och sensor som dina patienter har laddat upp till 

CareLink™ Personal, ett webbaserat behandlingssystem som används 

tillsammans med CareLink Pro.
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Funktioner     

CareLink Pro är en programvara för diabetesbehandling som ska 

användas på en persondator (PC). Programmet har följande 

funktioner:

• Patientjournaler kan skapas för att lagra uppgifter som samlats in 

från en patients enhet och även behandlingsuppgifter från patientens 

CareLink Personal-konto. 

• Uppgifter från insulinpumpar, monitorer och blodsockermätare kan 

skickas till systemet, sparas och sedan användas för att generera 

rapporter.

• Den kan även samverka med CareLink Personal-systemet, så att det 

går att komma åt uppgifter om enheterna som patienterna har sparat. 

En användbar funktion om man vill ta fram aktuella rapporter mellan 

patientens kontrollbesök, eller om man vill slippa läsa av uppgifter 

från enheten under kontrollbesöken. 

• Olika behandlingsrapporter kan skapas med de uppgifter från enheten 

som sparats i patientjournalen. Rapporterna kan ge svar på frågor 

kring behandlingen som patientens respons, mönster och undantag.

• Systemet anger automatiskt när det finns nya versioner av program-

varan som kan hämtas och installeras. På så sätt vet ni säkert att ni 

alltid har tillgång till de senaste funktionerna. 

• Det finns en hjälpfunktion som hjälper användare som inte känner till 

CareLink Pro. Hjälpfunktionen kommer med tips om de uppgifter 

patienten utför.

• Programvaran omfattar ett integrerat hjälpsystem som ger 

information om vissa punkter.

Säkerhet     

• CareLink Pro kan skyddas med ett lösenord.

• Överföringen av patientuppgifter från CareLink Personal krypteras 

med tekniken Secure Sockets Layer (SSL), som är standard inom 

branschen.

Relevanta dokument     

Denna bruksanvisning innehåller inte specifik produktinformation. 

Nedanstående dokument kan ge dig utförlig information om diverse 

produkter: 
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OBSERVERA: Vad gäller
mätare från andra

tillverkare så hänvisas
till bruksanvisningarna

som följer med dessa
mätare.

• Bruksanvisningen till Paradigm Insulinpump

• Bruksanvisningen till Guardian REAL-Time monitor

• Bruksanvisning om sensorfunktioner

• Bruksanvisningen till ComLink

• Bruksanvisningen till CareLink USB

Hjälp             

Kontakta en lokal representant om du behöver mer hjälp med det här 

systemet. Använd följande URL för att få tillgång till internationell 

kontaktinformation:

http://www.medtronicdiabetes.com/help/contact/locations.html 

OBSERVERA: Vissa
enheter som är

kompatibla med denna
programvara kanske
inte är tillgängliga i

alla länder där
programvaran har

godkänts för
användning.

Kompatibla enheter    

CareLink Pro hämtar data från följande enheter:           

Insulinpumpar/glukosmonitorer 

Medtronic MiniMed-pumpar 508

Medtronic MiniMed Paradigm-pumpar 

511, 512, 712, 515, 715, 522, 722, 
522K, 722K, Paradigm® REAL-Time 
Revel™ (523, 723, 523K, 723K),  
Paradigm® Veo™ (554, 754)  

Guardian REAL-Time monitor CSS-7100
CSS-7100K

Tillverkare Blodsockermätare     

Medtronic Diabetes 
partnerenheter:

• Bayer CONTOUR® LINK

• LifeScan OneTouch® UltraLink™

• BD Paradigm Link® blodsockermätare
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LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch®UltraMini™

• OneTouch®  UltraEasy®

Bayer’s:

• BREEZE™

• BREEZE™ 2

• CONTOUR®

BD: • Logic®

Bayer Ascensia® DEX®-
familjen, inklusive dessa 
kompatibla mätare:

• Ascensia® DEX®

• Ascensia® DEX® 2 

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer Ascensia ELITE™-
familjen, inklusive dessa 
kompatibla mätare:

• Ascensia ELITE™

• Glucometer ELITE® XL 

Abbott

• Precision Xtra™ 

• TheraSense FreeStyle®, FreeStyle Flash™
• FreeStyle Papillion™ Mini 
• FreeStyle Mini
• Optium Xceed™
• Precision Xceed™

Roche

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Tillverkare Blodsockermätare     
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Motsvarande enheter       

Om du vill lägga till en enhet till systemet ska du välja märke och 

modell på en lista. Om märket och modellen inte finns med på listan 

kan du hitta en motsvarande enhet i tabellen nedan.

OBSERVERA: Mätarna
kan beställas från de

respektive tillverkarna.

Beställning                       

Kontakta en lokal Medtronic-representant om du vill beställa 

Medtronic Diabetes-produkter. Använd följande URL för att få tillgång 

till Medtronics internationella kontaktinformation:

http://www.medtronicdiabetes.com/help/contact/locations.html

Kommunikationsenheter                 

 Com-Station

används med pumpen MiniMed 508. (Se 
bruksanvisningen till Com-Station för 
närmare information om den maskinvara 
som krävs.)

ComLink

används med MiniMed Paradigm-pump och 
Guardian REAL-Time-monitor. (Se 
bruksanvisningen till ComLink för närmare 
information om den maskinvara som 
krävs.) 

Paradigm Link® blodsockermätare

används med MiniMed Paradigm-pump och 
Guardian REAL-Time-monitor. (Se 
bruksanvisningen till Paradigm Link®

blodsockermätare för närmare 
information om den maskinvara som 
krävs.)

CareLink™ USB
används med MiniMed Paradigm-pump och 
Guardian REAL-Time-monitor.

Datakommunikationskabel
används med blodsockermätare från 
andra tillverkare. Varje mätartillverkare 
bifogar en datakommunikationskabel.

Om din patient har någon av följande 
enheter

Välj den här enheten

• Bayer Ascensia® DEX®

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2 

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™ XL 

Precision Xceed™ Optium Xceed™
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Att använda bruksanvisningen   

I ordlistan förklaras termer och funktioner. De skrivsätt som används i 

denna bruksanvisning beskrivs i nedanstående tabell.

I denna bruksanvisning visas exempel på skärmar. Skärmarna i den 

verkliga programvaran kan avvika en aning från dessa.

Användarsäkerhet         

Indikationer 

CareLink Pro-systemet är avsett att användas som ett verktyg för att 

underlätta diabetesbehandling. Syftet med systemet är att omvandla 

information från insulinpumpar, blodsockermätare och system med 

kontinuerlig blodsockerövervakning till CareLink Pro-rapporter. 

Rapporterna ger information som kan användas för att identifiera 

trender och följa dagliga aktiviteter, såsom antalet kolhydrater, 

mattider, insulindosering och blodsockervärden. 

Term/stil Betydelse

Klicka tryck på den vänstra musknappen över ett objekt på 
skärmen för att välja detta 

Dubbelklicka tryck två gånger på den vänstra musknappen över ett 
objekt på skärmen för att öppna detta

Högerklicka
tryck på den högra musknappen över ett objekt på 
skärmen för att visa ett annat fönster eller en annan 
meny

Fetstil
används för ett alternativ eller en väg på en meny. Till 
exempel: Patient > New Patient

STORA BOKSTÄVER anger en knapp. Till exempel: SPARA

Kursiv stil används för namn på skärmar och fält. Till exempel: 
Skärmen rapporter

OBSERVERA: ytterligare information

OBS! varnar för en risk, som, om den inte undviks, kan leda 
till mindre eller medelsvåra skador på programvaran 
eller utrustningen.

VARNING! indikerar en möjlig risk, som, om den inte undviks, kan 
leda till dödsfall eller allvarlig personskada. Kan också 
beskriva möjliga allvarliga biverkningar och 
säkerhetsrisker.
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Varningar 

• Systemet är avsett att användas av sjukvårdspersonal som har 

erfarenhet av diabetesbehandling. 

• Systemresultaten är inte avsedda att ge medicinsk rådgivning och 

man får inte sätta tillit till dem i sådant syfte. 

• Produkten ska endast användas tillsammans med de enheter som 

anges i detta dokument. (Se Kompatibla enheter, på sidan 3.)

• Patienterna ska rekommenderas att kontrollera blodsockervärdet 

minst 4-6 gånger om dagen.

• Patienterna ska uppmanas att inte ändra behandlingen utan att 

samråda med sjukvårdspersonalen.

• Patienterna ska uppmanas att fatta beslut om behandlingen utifrån 

sjukvårdspersonalens riktlinjer och resultaten av blodsocker-

mätningar, inte utifrån glukossensorvärdena.

Kontraindikationer 

Denna programvara får inte användas med andra enheter än de som 

listas bland Kompatibla enheter, på sidan 3. Produkten får heller inte 

användas för behandling av andra medicinska tillstånd än diabetes.

Stäng alla aktiva program på din dator innan du öppnar de här 

programmen:

• CGMS® System Solutions™ programvara 

• Solutions® Pumps & Meters programvara 

• Guardian® Solutions® programvara 

• ParadigmPAL™

• CareLink™ Personal 

• Solutions® programvara för CGMS® iPro
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Navigera inom systemet 2

Vad innehåller det här kapitlet?
• Översikt: sida 8

• Öppna CareLink Pro: sida 8

• Arbetsområden: sida 10

• Huvudmenyfältet: sida 12

• Verktygsfält: sida 12

• Hjälpfunktionen: sida 13

• Learn More-länkar: sida 14

• Hjälpsystem: sida 14

Översikt

Läs igenom det här kapitlet och bekanta dig med CareLink™ Pro grafisk 

användargränssnitt (GUI). Användargränssnittet omfattar menyer, ett 

verktygsfält, ett navigationsfält, arbetsområden och ett hjälpfönster. 

Öppna CareLink Pro                  

1 Dubbelklicka på CareLink Pro-ikonen på skrivbordet.

Inloggningsskärmen visas om kliniken kräver att du anger ett 

lösenord.

 CareLink Pro
skrivbordsikon
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a. För in ditt lösenord i Password-fältet (Lösenord).

OBSERVERA: Lösenordet
är en tillvalsfunktion

som ställs in under
installationsprocessen.

b. Klicka på LOGIN.

Startskärmen visas.

2 Klicka på NEW PATIENT (NY PATIENT) om du vill starta en ny patient-

rapport. Om du vill öppna en befintlig patientrapport ska du klicka 

på OPEN PATIENT (ÖPPNA PATIENT).

        

huvudmenyer

aktivt 
arbetsområde

ta fram patientlistanlägg till en ny patient

navigeringsfält

statusfält

Rapporternas
arbetsområde

Enhetens
arbetsområde

Profilens
arbetsområde

visa/göm hjälpfönstret
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Arbetsområden     

OBSERVERA: I de andra
kapitlen i denna

bruksanvisning finns
mer information om
arbetsområdena och
om hur de används.

Om en patientrapport är öppen kan du klicka på en av knapparna i 

navigeringsfältet för att visa motsvarande arbetsområde. Använd 

dessa arbetsområden för att föra in eller välja information så att 

CareLink Pro-uppgifterna för den patienten kan utföras.

• Profil: Gör att du kan spara sådan patientinformation som namn och 

födelsedatum. Det här arbetsområdet tillåter även en länk till 

patientens CareLink Personal-konto.

• Enheter: Gör att du kan spara information som krävs för att kunna 

avläsa en patients enheter.

• Rapporter: Gör att du kan välja parametrar och rapporter som ska 

genereras för patienten.

Innan en profil har lagts till och sparats för en patient är det bara 

arbetsområdet Profile (Profil) som är tillgängligt för den patienten. 

Innan enheter har lagts till för en patient är det bara arbetsområdena 

Profile och Devices (Enheter) som är tillgängliga för den patienten.
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Arbetsområden

Arbetsområdet Enheter

Arbetsområdet Profiler

Arbetsområdet Rapporter

Profil

Enheter

Rapporter
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Huvudmenyfältet       

Nedan visas de alternativ som finns tillgängliga genom huvudmenyn. 

Vissa av dessa alternativ kan även öppnas med tangentkombinationer 

som anges bredvid alternativet på menyn (t.ex. Ctrl+N för Ny 

patient). Det går även att använda navigationsfältet eller verktygs-

fältet för att komma till vissa alternativ på menyn.

Verktygsfält     

CareLink Pros verktygsfält gör att du snabbt kommer åt funktioner 

som används ofta. Följande knappar finns i verktygsfältet.

Knapp Namn Funktion

Lägg till patient
Öppnar ett arbetsområde för Profile så 
att du kan lägga till en ny patientjournal 
till systemet.

Öppna patient
Öppnar tabellen Patient Lookup där du 
kan välja vilken befintlig patientjournal 
du vill visa.

Hjälp
Visar eller gömmer hjälpfönstret. Klicka 
för systemhjälp som tar hänsyn till var du 
befinner dig i systemet. 
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Patientflikar

Efter att du har öppnat en patientjournal visas en flik bredvid 

verktygsfältet med patientens namn. När en flik är aktiv innebär det 

att en patients journal och arbetsområde är aktiva och att du kan 

utföra CareLink Pro-uppgifter för patienten.

En patientjournal kan aktiveras genom ett enkelt klick på patient-

fliken. Stäng journalen genom att klicka på CLOSE (STÄNG) på 

patientens flik.

Hjälpfunktionen     

Det finns en hjälpfunktion i hela CareLink Pro. Den öppnar ett fönster 

med hjälp och tips om handlingar som kan utföras i den del av 

systemet som är aktivt. Hjälpfönstret kan även ha länkar till 

>>learn more (lär mer). Om du klickar på dem tar länkarna dig till det 

relevanta avsnittet på onlinehjälpen för mer information. Standard-

inställningen är att hjälpfunktion är aktiverad. Det går dock att 

stänga av den när som helst.

Knappen
STÄNG 

inaktiv flik aktiv flik

Knappen stäng
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Slå av och på hjälpfunktionen      
Knappalternativ

• Klicka på GUIDE ME (HJÄLP) för att slå av eller på hjälpfunktionen.

Menyalternativ

• Välj Help > Guide Me för att aktivera eller inaktivera funktionen.

Learn More-länkar     

Learn More-länkarna tar dig till ett liknande ämne i online hjälp-

systemet. Det finns i hela systemet, i hjälpfönster eller i program-

varan. Klicka på >> learn more om du inte vet hur du ska fortsätta 

eller vilka värden du ska föra in.

Hjälpsystem     

Hjälpsystemet hjälper dig under användningen av CareLink Pro. Det 

ger information om hur uppgifterna i programvaran ska utföras. 

Gör något av det följande för att komma till hjälpsystemet:

• Välj Help > Medtronic CareLink Pro Help.

• Tryck på F1.

Hjälpknapp

learn more-länk
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Komma igång 3

Vad innehåller det här kapitlet?
• Innan du börjar: sida 15

• Öppna och stänga patientjournaler: sida 17

• Ställa in systempreferenser: sida 18 

I det här kapitlet beskrivs hur man startar CareLink™ Pro, öppnar 

och stänger patientjournaler och ställer in preferenser som gäller 

för alla patienter i systemet. 

Innan du börjar

Om det är första gången du använder CareLink Pro måste du fylla i 

dina General preferences (allmänna inställningar, se Allmänna 

preferenser, på sidan 18). Dessa inställningar avgör hur vissa saker 

visas i programvaran och på rapporter samt hur du vill att 

systemet ska kommunicera med Internet.

Inställningarna kan göras när som helst. Det kan hända att du vill 

vänta tills du har bekantat dig med CareLink Pro innan du för in de 

andra inställningarna.
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Primära systemuppgifter     

I tabellen nedan visas de huvuduppgifter som du förmodligen vill 

utföra första gången du ställer in och använder CareLink Pro. 

Dessutom anger den var i bruksanvisningen du kan hitta information 

om de olika uppgifterna.

Steg Var?

Bekanta dig med CareLink Pro-
gränssnittet. Kapitel 2, Navigera inom systemet

Definiera de övergripande systemval 
som kliniken ska använda.

Ställa in systempreferenser, på 
sidan 18

Skapa profiler för alla patienter. Lägga till nya profiler, på sidan 25

Länka till patienternas CareLink 
Personal-konton.

Länka till CareLink Personal 
(alternativ), på sidan 26

Lägg till patientens pump och mätare till 
profilen. Lägga till en enhet, på sidan 36

Läs av uppgifter från patientens pump 
och mätare.

Läs av uppgifter om enheten, på 
sidan 42

Ställ in och generera rapporter för alla 
patienter.

Skapa rapporter, på sidan 45

Gör regelbundna säkerhetskopior av 
CareLink Pro-databasen.

Säkerhetskopia av en databas, på 
sidan 58

Uppdatera CareLink Pro.
Programvaruuppdateringar, på 
sidan 57
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Öppna och stänga patientjournaler

Öppna patientjournaler           

Upp till sex patientjournaler kan öppnas samtidigt. Se Lägga till nya 

profiler, på sidan 25 om du inte har skapat några patientprofiler 

ännu.

1 Välj File > Open Patient eller klicka på OPEN PATIENT (ÖPPNA 

PATIENT). En patientlista som påminner om den följande visas.

OBS! Om du får ett
meddelande om att

alltför många
patientjournaler är

öppna ska du klicka på
OK, stänga en journal

och sedan fortsätta.

2 Sök patienter genom att föra in hela eller delar av deras namn i 

fältet Find a Patient (Hitta en patient). När den patient du sökte 

markeras ska du klicka på OPEN (ÖPPNA) och dubbelklicka på raden 

eller trycka på ENTER. Du kan även navigera igenom listan med 

piltangenterna upp och ned på tangentbordet. 

Patientens arbetsområde Devices (om inga enheter har lagts till än) 

eller Reports visas.

3 Klicka på PROFILE i navigationsfältet om du vill visa patientens 

arbetsområde Profile.

Stänga patientjournaler        

1 Kontrollera att den patientjournal du vill stänga är aktiv (fliken är 

markerad).

2 Gör något av följande:

a. Välj File > Close Patient.

b. Klicka på CLOSE (STÄNGA) på patientens flik.

Öppna patient
knapp

Profilknapp

knappen stäng
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c. Tryck på Ctrl-F4.

Ställa in systempreferenser             

Dessa preferenser gäller för alla patienter i systemet. Mer 

information om preferenser som endast påverkar enskilda patienter 

finns i Bekräfta rapportinställningarna, på sidan 49.

Preferenserna visas i följande grupper:

• General (Allmänt)

– Blodsockerenheter

– Kolhydratenheter

– Kommunikation

– Felsökning
• Patient Profile (Patientprofil)

– Välj och arrangera datafälten om patientprofiler.
• Patient Lookup (Patientstruktur)

– Anpassa och ändra ordningen på de fält som visas då du väljer 
Open Patient för att ta fram en lista med patienter.

• Report Generation (Generera rapporter)

– Välj vilka datafält du vill visa då du i datatabellen väljer vad som 
ska ingå i Daily Detail-rapporten.

Allmänna preferenser           
1 Välj Tools > Options. Följande fönster visas.
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2 Klicka på knappen för att välja det värde du vill ha:

– Glukosenheter: mmol/l eller mg/dl

– Kolhydratenheter: gram eller utbyten

a. Om du väljer utbyten för kolhydratenheter ska du föra in 
motsvarande siffra i fältet gram motsvarar 1 utbyte.

3 Markera rutan (aktivera) eller avmarkera rutan (inaktivera) för 

följande kommunikationer:

OBS! Se till att du följer
klinikens eller

dataavdelningens
riktlinjer då du ställer

in kommunikations-
preferenserna.

– Automatically check for software updates (Automatisk 
kontroll av programvaruuppdateringar): om detta har valts 
skickas ett meddelande till alla aktiva system med CareLink Pro 
så snart det finns en uppdatering av programvaran. Användaren 
har då en möjlighet att hämta och installera uppdateringarna. 
Om du föredrar en kontrollerad distribution av uppdateringar ska 

denna ruta avmarkeras.

– Synchronize with CareLink™ Personal (Synkronisera med 

CareLink™ Personal): Om du vill att systemet automatiskt ska 
synkronisera patienternas CareLink Personal-uppgifter varje gång 
du öppnar deras profil ska du markera rutan Synchronize with 
CareLink Personal. Om denna ruta avmarkeras måste du manuellt 
synkronisera CareLink Personal-uppgifterna för varje patient.

4 För att markera eller ta bort bocken i rutan, klicka i avsnittet 

Felsökning. Om rutan är markerad kommer programmet att spara en 

rapport med avläsningar av enheten för felsökning.

5 Klicka på OK för att spara de allmänna preferenserna. 
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Preferenser för patientprofilen         

1 Välj Tools > Options.

2 Klicka på fliken Patient Profile. Följande fönster visas.

Val av datafält        
1 Markera rutorna för att lägga till de fält du vill ha.

OBS! Förnamn och
efternamn kan inte tas

bort.

2 Avmarkera rutan om du vill ta bort ett fält från profilen.

3 Om fältet ska vara obligatoriskt ska rutan i spalten Required 

markeras. Alla fält som är obligatoriska måste fyllas i innan det går 

att skapa en profil.

Lägg till ett skräddarsytt fält     

1 Markera rutan till vänster om ett tomt skräddarsytt fält.

2 För in text så att fältet får ett namn (t.ex. kontaktperson i 

nödlägen). Det fältnamnet kommer att visas på patientprofilen.

3 Om fältet ska vara obligatoriskt ska rutan i spalten Required 

markeras.

Markera rutorna för de fält du vill ha med i profilen. Använd upp- och nedpilarna för
att lägga fälten i rätt ordningsföljd.
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OBS! Om du vill ta bort
ett skräddarsytt fält
från profilen ska du

avmarkera rutan
bredvid de(t) fält du vill

ta bort.

Ändra ordningen på datafälten         

• Välj det fält du vill flytta och klicka på upp- eller nedpilen för att 

flytta det. (Pilen överst och nederst flyttar fältet till den översta eller 

understa positionen på listan.) 

Slutför preferenserna för patientprofilen

• Klicka på OK när du har fått med alla fält du vill ha i rätt ordning.

Nu har patientprofilerna alla fält, i den ordning, som du valt.

Preferenser för Patient Lookup         

1 Välj Tools > Options.

2 Klicka på fliken Patient Lookup. Följande fönster visas.

Val av uppgifter som ska visas        
• Markera rutorna för att välja vilka uppgifter du vill visa, eller 

avmarkera rutorna för uppgifter du inte vill visa i tabellen Patient 

Lookup.

Upp- & ned-
 pilar

Markera rutorna för att välja de uppgifter du vill ha med i tabellen Patient Lookup. 
Använd upp- och nedpilarna för att lägga kolumnerna i rätt ordningsföljd.
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OBS! Förnamn och
efternamn kan inte tas

bort.

Ändra kolumnernas ordningsföljd        
• Om du vill ändra ordningsföljden på kolumnerna i tabellen Patient 

Lookup ska du välja den kolumn som ska flyttas och klicka på upp- 

eller nedpilarna. (Pilen överst och nederst flyttar kolumnen till den 

översta eller understa positionen på listan.)

OBS! Den kolumn som
står överst på listan

Column Display Order
kommer att visas som

första kolumn i tabellen
Patient Lookup. Den

kolumn som står
nederst kommer att

visas som sista kolumn i
tabellen.

Slutför preferenserna för patient lookup

• Klicka på OK när du har fått med alla kolumner du vill ha i rätt 

ordning.

Tabellen Patient Lookup har nu uppgifterna och kolumnerna i den 

ordning du valt.

Preferenser för rapportgenerering        
Datatabellen visas under den valda delen av rapportprocessen. Den 

här tabellen ska innehålla de uppgifter som sjukvårdspersonalen 

tycker är mest användbara för att välja datum för att ta fram Daily 

Detail-rapporter.

OBS! Mer information
om hur dessa

preferenser påverkar
datatabellen då

rapporten skapas finns i
Välja rapporttyper och

datum som ska omfattas,
på sidan 51.

1 Välj Tools > Options.

2 Klicka på fliken Report Generation. Följande fönster visas.

Upp- & ned-
 pilar

Markera rutorna för de uppgifter du vill ha med i datatabellen. Använd upp- och 
nedpilarna för att lägga kolumnerna i rätt ordningsföljd.
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Val av uppgifter som ska visas        

• Markera rutorna för att välja vilka uppgifter du vill visa, eller 

avmarkera rutorna för uppgifter du inte vill visa i datatabellen.

Ändra kolumnernas ordningsföljd      

• Om du vill ändra ordningsföljden på kolumnerna i datatabellen ska du 

välja den kolumn som ska flyttas och klicka på upp- eller nedpilarna. 

(Pilarna överst och nederst flyttar kolumnen till den översta eller 

understa positionen på listan.)

OBS! Punkter som står
överst på listan Column
Order kommer att visas

som första kolumn i
datatabellen. Punkter

som står nederst
kommer att visas som

sista kolumn i
datatabellen.

Slutför preferenserna för rapportgenerering

• Klicka på OK när du har fått med alla kolumner du vill ha i rätt 

ordning. 

Datatabellen har nu uppgifterna och kolumnerna i den ordning du 

valt.

Upp- & ned-
 pilar
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Profiler 4

Vad innehåller det här kapitlet?
• Innan du börjar: sida 24

• Lägga till nya profiler: sida 25

• Redigera patientprofiler: sida 25

• Radera patientuppgifter ur systemet: sida 25

• Länka till CareLink Personal (alternativ): sida 26

En profil motsvarar framsidan på en journal. Den innehåller patient-

uppgifter som namn och födelsedatum. En profil krävs innan uppgifter 

kan samlas in från enheten och användas för rapporter om 

behandlingen.

Profiler gör det även möjligt att lägga in en länk till patientens 

CareLink Personal-konto. Efter att länken har lagts in kan du när som 

helst hämta patientuppgifter som sparats i CareLink Personal — utan 

att patient behöver vara där.

Innan du börjar

Det kan hända att du vill anpassa patientprofilerna så att de bara 

innehåller den typ av information som du vill samla in. Läs mer om 

detta under Preferenser för patientprofilen, på sidan 20.

Dessutom måste du ha ett användarnamn och ett lösenord för att 

kunna lägga in en länk till patientens CareLink Personal-konto. 

Patienten måste vara närvarande för att tillhandahålla dessa 

uppgifter.
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Lägga till nya profiler        

Varje gång du vill lägga till en patient till CareLink Pro-systemet 

måste du börja med att fylla i en profil för patienten. 

1 Välj File > New Patient eller klicka på knappen ADD PATIENT (LÄGG 

TILL PATIENT). 

Arbetsområdet Profile visas (se exempel på sidan 11). 

OBSERVERA:Klicka på
>>customize fields

(skräddarsy fälten) för
att lägga till eller ändra

fält i patientprofilen. Se
Preferenser för

patientprofilen, på
sidan 20.

2 Fyll i fälten i avsnittet Patient Profile.

3 Klicka på SAVE (SPARA).

Den nya patientprofilen läggs till i CareLink Pro databas. Ett 

bekräftelsemeddelande om att profilen har sparats visas.

Om ett obligatoriskt fält inte har fyllts i då patientprofilen sparas 

visas ett meddelande bredvid det fältet. Det går inte att spara 

profilen innan det fältet har fyllts i.

Redigera patientprofiler         

1 Kontrollera att patientens arbetsområde Profile är öppet.

2 Klicka på EDIT (REDIGERA).

3 Redigera de uppgifter som ska ändras i avsnittet Patient Profile.

4 Klicka på SAVE.

Ett bekräftelsemeddelande om att profilen har sparats visas.

Radera patientuppgifter ur systemet        

1 Kontrollera att patientens arbetsområde Profile är öppet. 

2 Kontrollera att det är just den patienten du vill radera. Om en 

patientprofil raderas innebär det också att alla uppgifter i CareLink 

Pro databas raderas och det kan inte ångras.

3 Klicka på >> delete patient record (radera patientjournal) ovanför 

synkroniseringsavsnittet på profilen.

Ett meddelande visas som varnar dig om att alla patientuppgifter 

kommer att raderas när du tar bort journalen. 

4 Klicka på YES för att ta bort patientjournalen.

Lägg till patient
knapp
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Länka till CareLink Personal (alternativ)         

Om patienten tillåter det kan du lägga in en länk till patientens 

CareLink Personal-konto. Detta webbaserade verktyg gör att 

patienterna kan skicka och spara uppgifter som hämtats från enheten 

samt köra olika behandlingsrapporter. 

När du har länkat till patientens CareLink Personal-konto kan du 

hämta de uppgifter från enheten som sparats där för att generera 

CareLink Pro-rapporter. Rapporter kan genereras när som helst, även 

mellan kontrollbesök. Dessutom innebär det att enheten sällan eller 

aldrig behöver avläsas under patientens kontrollbesök.

Om en patient inte har något CareLink Personal-konto kan du mejla 

patienten och uppmana honom eller henne att skapa ett. 

Länka till ett befintligt konto             
OBSERVERA: Patienten

måste vara närvarande
för att dessa steg ska

kunna slutföras.

1 Kontrollera att du har Internetanslutning.

2 Öppna patientens arbetsområde Profile.

3 Kontrollera att alla obligatoriska fält i avsnittet Patient Profile är 

ifyllda.

4 Klicka på LINK TO EXISTING ACCOUNT (LÄNKA TILL BEFINTLIGT 

KONTO). 

CareLink Personals inloggningsskärm visas.
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5 Be patienten att:

a. Skriva in användarnamn och lösenord.

b. Klicka på SIGN IN (ANMÄLAN). 

En åtkomstsida visas, baserad på patientens registrerings-

inställningar för språk och region.

6 Be patienten att:

a. Läsa igenom användarvillkoren.

b. Klicka på rutan bredvid I agree to the Terms of Use above (Jag 
accepterar villkoren ovan)... 

c. Klicka på GRANT ACCESS (BEVILJA ÅTKOMST).

d. Tala om för dig när sidan Thank You (tack) visas.
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Du kan skriva ut användarvillkoren åt patienten genom att klicka på 

utskriftsknappen.

Nu har du en länk till den här patientens CareLink Personal-konto. Se 

Hämta uppgifter från ett länkat konto, på sidan 29.

Mejla en inbjudan           

Gör så här för att melja en inbjudan till en patient om att öppna ett 

CareLink Personal-konto:

1 Öppna patientens arbetsområde Profile.

2 Kontrollera att alla obligatoriska fält i avsnittet Patient Profile är 

ifyllda.

3 Klicka på SEND E-MAIL INVITATION TO PATIENT (MEJLA INBJUDAN TILL 

EN PATIENT).
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4 Kontrollera att Patientnamn, e-post och Språk... har fyllts i korrekt.

5 Klicka på SEND (SKICKA). 

I patientens profilstatusområde bekräftas att mejlet har skickats.

Koppla bort en patients CareLink Personal-konto från CareLink Pro

Du kan koppla bort en patients CareLink Personal-konto från CareLink 

Pro. Detta är endast möjligt efter att en patient har blivit länkad. Det 

förhindrar CareLink Pro från att fortsätta samla in data från 

patientens CareLink Personal konto. Det påverkar inte patientens 

användning av sitt CareLink Personal-konto.

1 Öppna patientjournalen och du kommer till området Profiler.

2 Klicka på UNLINK ACCOUNT (koppla bort konto).

3 Klicka på Yes (Ja) för att bekräfta. Patientens profil är inte längre 

kopplad till CareLink Pro.

Statuset är ändrat från "Not linked" (inte länkad) och LINK TO 

EXISTING ACCOUNT (länka till existerande konto) samt SEND E-MAIL 

INVITATION TO PATIENT (skicka en e-mail med inbjudan till 

patienten) knapparna visas nu.

Hämta uppgifter från ett länkat konto             

Om du är länkad till en patients CareLink Personal-konto skickas alla 

nya uppgifter från det kontot automatiskt till dig varje gång du 

öppnar den patientprofilen i CareLink Pro. 
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OBSERVERA: För att
säkerställa det ska du

gå till Tools > Options >
General och kontrollera

att rutan bredvid
“Synchronize with

Medtronic CareLink
Personal” är markerad.

Följ dessa steg för att hämta en patients CareLink Personal uppgifter 

när som helst efter att du har öppnat den patientprofilen:

1 Kontrollera att patientens arbetsområde Profil är öppet och att du 

är ansluten till Internet.

2 Välj Tools > Synchronize Patient Data.

Synkroniseringsikonen på patientens flik roterar. Då ikonen stannar 

har processen slutförts.

OBSERVERA: Om
patienten inte längre

vill att du ska kunna se
CareLink Personal-

uppgifterna, kan
funktionen stängas av

på menyn OPTIONS. Ett
meddelande visas om

detta.

3 Alla ytterligare uppgifter som hämtats från CareLink Personal visas i 

patientrapporterna. 

synkroniseringsikon
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Maskinvaruinställning 5

Vad innehåller det här kapitlet?
• Innan du börjar: sida 31

• Anslutning av enheter: sida 32

Det här kapitlet innehåller diagram som visar hur man ska ställa in 

patientens enhet så att din dator kan hämta uppgifter från den.

Du måste ha tillgång till patientens enhet för att kunna läsa 

uppgifter direkt från den. Däremot kan du hämta uppgifter från en 

patients CareLink™ Personal-konto, så slipper du läsa dem direkt 

från enheten.   

Innan du börjar

För att kunna läsa uppgifter direkt från en enhet måste du ha 

tillgång till patientens enhet och kablar eller kommunikations-

enheter som krävs för att överföra data till datorn.
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Anslutning av enheter              

OBSERVERA: Mer
information finns i de

instruktioner som

CareLink™ Pro visar då
du läser av enheter.

Granska översiktsdiagrammet för att få en allmän uppfattning om hur 

enheter ska ställas in för att kunna kommunicera med datorn. 

Följande diagram illustrerar specifika aspekter av enhetens 

kommunikation. 

OBSERVERA: Det här
exemplet visar hur

CareLink USB används
för kommunikation
mellan pumpen och

datorn.

Översikt över maskinvaruinställningar               

TM

CareLinkUSB

CareLink USB

PC

Paradigmpump
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Diagram över maskinvaruanslutningar                                    

                      

PC-anslutningar

USB
port

Seriell
port
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anslut till en
seriell port på

datorn

ComLink som används med pumpar i Paradigmserien

Extra komponenter

Com-Station som används med MiniMed 508-pumpar och för genommatning 
av mätaren
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Enheter 6

Vad innehåller det här kapitlet?
• Innan du börjar: sida 36

• Lägga till en enhet: sida 36

• Aktivera eller inaktivera en enhet: sida 41 

• Läs av uppgifter om enheten: sida 42

Information du behöver för att läsa av en patients enhet (märke, 

modell, serienummer, etc.) lagras i arbetsområdet Devices

(Enheter). Den behöver alltså inte anges varje gång du läser av 

uppgifter från enheten. 

Enheter i arbetsområdet Devices (Enheter) sparas på en av de två 

listorna—Active Devices (Aktiva enheter) eller Inactive Devices

(Inaktiva enheter). När du lägger till en enhet hamnar den 

automatiskt på listan Active Devices. Du kan bara läsa av uppgifter 

från enheter som visas på listan Active Devices. De är sannolikt de 

enheter som din patient använder. 

Andra enheter som patienten kan ha, men som han eller hon inte 

använder just nu, kan sparas på listan Inactive Devices. Det gör att 

informationen sparas och att dessa enheter kan aktiveras när det 

behövs.
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Innan du börjar

Innan du kan öppna arbetsområdet Enheter för en patient måste han 

eller hon ha en profil som sparats i systemet. Se Kapitel 4, Profiler.

För att du ska kunna lägga till en enhet eller läsa uppgifter direkt från 

den måste den kommunicera med datorn. I Kapitel 5, 

Maskinvaruinställning beskrivs hur du ska ställa in enheter så att de 

kan kommunicera med datorn.

Lägga till en enhet            

Däremot kan du hämta uppgifter från en patients CareLink Personal-

konto för en enhet som inte lagts till ännu. Sådana enheter läggs 

automatiskt till när uppgifter synkroniseras mellan CareLink Personal 

och CareLink Pro.

OBSERVERA: Det kan
bara finnas en aktiv

pump per patient. Om
du lägger till en ny

pump flyttas den
tidigare till den
inaktiva listan.

Lägga till en Medtronic-pump eller Guardian-monitor           

1 Kontrollera att den enhet du lägger till är inställd så att den kan 

kommunicera med datorn. (Se Kapitel 5, Maskinvaruinställning för 

instruktioner om anslutningen.)

2 Klicka på patientfliken eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

3 Klicka på DEVICES (ENHETER) för att komma till arbetsområdet 

Devicesför patienten (se exemplet på sidan sidan 11).

4 Klicka på ADD DEVICE (LÄGG TILL ENHET).

5 Välj Medtronic Pump/Guardian. Guiden Add Medtronic 

Pump/Guardian visas.

knappen ENHETER
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OBSERVERA:
Pumpmodellen anges på

pumpens baksida eller
på pumpstatusskärmen.

6 Klicka på knappen som avser den enhet du vill lägga till. 

Om du har valt MiniMed 508-pumpen ska du gå du vidare till steg 9.

7 Klicka på NEXT (NÄSTA). Sidan med Serial Number (serienummer)

visas.

OBSERVERA: Ett
felmeddelande visas om

du för in fel
serienummer. Titta på

exemplen på den här
sidan och kontrollera

att du har fört in
samma uppgifter som
på pumpens baksida.

För in de sex tecknen på
nytt om det behövs.

8 Använd exemplen på den här sidan för att hitta serienumret 

(bestående av sex tecken) på den enhet du ska lägga till. (Om du 

behöver mer hjälp för att hitta numret kan du klicka på 

>>learn more.) Skriv in de sex tecknen i fältet Device serial number 

(Enhetens serienummer).

9 Klicka på NEXT. Sidan med Communication Options (kommuni-

kationsalternativ) som påminner om den följande visas.

10 Klicka på nedrullningsmenyn Choose Port och välj den port som 

ComLink, Paradigm Link®, CareLink USB eller Com-Station ansluts till 
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på din dator. Om du inte är säker på vilken port som är den rätta 

väljer du Auto Detect (eller USB).

11 Klicka på NEXT. Sidan Test Connection (testa anslutningen) som ser 

ut som den följande visas.

12 Följ enhetens instruktioner och klicka på TEST.

Ett meddelande visas för att ange om anslutningen lyckades eller 

inte. Om den lyckades ska du gå vidare till nästa steg. 

OBSERVERA: Det här
testet läser inte av

några pumpuppgifter
utan bekräftar bara att

kommunikationen
mellan pumpen och

datorn fungerar.

Om den inte fungerar ska du kontrollera att maskinvaran mellan 

enheten och datorn har anslutits på rätt sätt. Klicka även på BACK 

(tillbaka) på sidorna i guiden för att kontrollera att du fört in rätt 

uppgifter om enheten.

13 Klicka på DONE (färdig).

Pumpen har lagts till på patientens lista med Active Devices (aktiva 

enheter).
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Lägga till en mätare             

1 Klicka på patientfliken eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Kontrollera att den mätare du lägger till kommunicerar med datorn. 

(Se Kapitel 5, Maskinvaruinställning för de olika anslutningsstegen.)

3 Klicka på DEVICES för att komma till arbetsområdet Devices för 

patienten (se exemplet på sidan sidan 11).

4 Klicka på knappen ADD DEVICE (lägg till enhet).

5 Välj Blodsockermätare. Guiden Add Blood Glucose Meter (Lägg till 

blodsockermätare) visas.

6 Klicka på knappen för att ange märket på mätaren.

7 Klicka på NEXT. Sidan Meter Model (mätarmodell) visas (denna sida 

ser olika ut beroende på mätarens tillverkare).

8 Klicka för att välja den mätarmodell som du lägger till. 
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9 Klicka på NEXT. Sidan med Communication Options visas.

OBSERVERA: Det går
bara att välja de
alternativ som är

giltiga för den mätare
du lägger till.

10 Klicka på nedrullningsmenyn Choose Port och välj den port som 

ComLink, Paradigm Link® eller CareLink USB ansluts till på din dator. 

Om du inte är säker på vilken port som är den rätta väljer du Auto
Detect.

11 Klicka på NEXT. Sidan med Test Connection (Testa anslutningan)

visas.

12 Följ mätarens instruktioner och klicka på TEST.

Ett meddelande visas för att ange om anslutningen lyckades eller 

inte. Om den lyckades ska du gå vidare till nästa steg. 

Om den inte fungerar ska du kontrollera att maskinvaran mellan 

enheten och datorn har anslutits på rätt sätt. Klicka även på BACK 

(tillbaka) i guiden för att kontrollera att du fört in rätt uppgifter.

13 Klicka på DONE (färdig).

Mätaren har lagts till på patientens lista med Active Devices.
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Aktivera eller inaktivera en enhet      

Patientenheterna kan flyttas mellan listorna Active Devices och 

Inactive Devices efter behov. En enhet måste vara aktiv för att man 

ska kunna läsa av uppgifter från den. 

Du kan ha så många mätare du vill på listan med Active Devices, men 

bara en pump. Kontrollera att du verkligen vill inaktivera den aktuella 

pumpen innan du lägger till en ny.

Inaktivera en enhet              

1 Klicka på patientfliken eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Klicka på DEVICES för att komma till arbetsområdet Devices för 

patienten.

OBSERVERA: Enheterna
kan finnas med på

listan med ett
motsvarande namn. Se

Motsvarande enheter, på
sidan 5.

3 Klicka på >> make this device inactive (inaktivera den här 
enheten) under den enhet du vill inaktivera.

Enheten flyttas till listan med Inactive Devices.

Återaktivera en enhet               

1 Klicka på patientfliken eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Klicka på DEVICES (enheter). Patientens arbetsområde Devices visas.

3 Klicka på >> activate this device (aktivera den här enheten) under 

den enhet du vill aktivera.

Enheten flyttas till listan med Active Devices.

Radera en enhet             

Gör så här för att radera en enhet och dess uppgifter från arbets-

området Devices och CareLink Pro-systemet:

1 Klicka på patientfliken eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Klicka på DEVICES för att komma till arbetsområdet Devices för 

patienten.

3 Kontrollera att enheten finns med på listan med Inactive Devices.

Om den inte gör det ska du klicka på >> Inactive Devices på den 

lista där den står nu.
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4 Klicka på >> delete this device (radera den här enheten) under 

den enhet du vill radera.

Ett meddelande visas som varnar dig om att enheten och alla data på 

denna kommer att raderas från patientens journal.

5 Klicka på YES för att radera enheten. 

Enheten och dess uppgifter tas bort från arbetsområdet Devices och 

från CareLink Pro-systemet. Uppgifter från den här enheten kan inte 

längre användas i rapporter.

Läs av uppgifter om enheten            

Ett sätt att få uppgifter från enheten är att länka till patientens 

befintliga CareLink Personal-konto. (Se Länka till CareLink Personal 

(alternativ), på sidan 26.) Ett annat sätt är att läsa av dem direkt från 

enheten, på det sätt som beskrivs i detta kapitel. 

Uppgifter från patientens enhet kan läsas av CareLink Pro om enheten 

finns med på listan med Active Devices och om den kommunicerar 

med datorn. Efter att du har fått fram de här uppgifterna kan du 

använda dem för att skapa rapporter som underlätta bedömningen av 

patientens behandling. (Se Kapitel 7, Rapporter om du vill läsa mer 

om rapporter.)

Detta är några av de typer av information som CareLink Pro-systemet 

samlar in från en insulinpump vid nedladdning:  

• Olika inställningar på pumpen, som alarmläget, signalvolymen och 

tiden

• Basaldoser insulin doseras

• Bolushändelser och tillförda mängder

• Information från Bolusguiden

• Primingmängder

• Stopperioder

• Sensorglukosvärden under en tidsperiod, på pumpar med 

sensorfunktioner

Systemet kan också samla in följande data från Guardian REAL-Time-

systemet:

• Sensorglukosvärden (SG)  

• Sensorkoefficientvärden 

• Sensorkalibreringsfaktorer 
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• Måltidsmarkörer 

• Insulininjektioner

Dessutom kan olika typer av information som lagrats i en blodsocker-

mätare överföras till systemet under avläsning av enheten. 

VARNING: Annullera eller slutför alla temporära basaldoser eller aktiva bolusar och radera 
alla aktiva alarm. Pumpen stoppas under avläsningen. Kontrollera att pumpen startar igen 
efter att avläsningen har slutförts.

VARNING: Använd inte fjärrkontrollen då pumpen avläses. 

Om pumpbatteriet nästan är tomt skickar pumpen inte några uppgifter till datorn. Byt ut 
batteriet om statusen anger att batteriet är nästan tomt.    

1 Klicka på patientfliken eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Kontrollera att patientens enhet kommunicerar med datorn. (Se 

Kapitel 5, Maskinvaruinställning.)

3 Klicka på DEVICES för att komma till arbetsområdet Devices för 

patienten.

OBSERVERA: Enheterna
kan finnas med på

listan med ett
motsvarande namn. Se

Motsvarande enheter, på
sidan 5.

4 Lokalisera den enhet du vill hämta uppgifter från i listan Active 

Devices, och se till att uppgifterna under Choose port (välj port) är 

korrekta.

– Klicka på nedrullningsmenyn Amount of Data för pumpar och ange 
hur många pumpuppgifter du vill att CareLink Pro ska läsa av.

5 Klicka på motsvarande READ DEVICE-knapp.

6 Följ specifika instruktioner för enheten och klicka på OK.

7 CareLink Pro visar en förloppsindikator som visar hur stor del av 

avläsningen som har slutförts.

8 Om du klickar på CANCEL under avläsningen av enheten visas ett 

varningsmeddelande om att avbrott av åtgärden kan göra att alla 

uppgifter som hittills avlästs går förlorade. Du måste klicka på READ 

DEVICE-knappen (steg 5) för att starta om nedladdningen.

– Klicka på YES för att annulera. 

– Klicka på NO om du vill fortsätta att läsa av uppgifterna.

När systemet har avslutat avläsningen visar ett meddelande som 

bekräftar att avläsningen av enheten är klar.

9 Klicka på OK. 

– Se pumpens bruksanvisning om du vill starta den igen.

Se Kapitel 9, Felsökning för närmare anvisningar om CareLink Pro inte 

kan hämta några uppgifter från enheten.
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Rapporter 7

Vad innehåller det här kapitlet?
• Innan du börjar: sida 44

• Skapa rapporter: sida 45

• Om rapporter: sida 53

• Exportera data: sida 54

Med hjälp av arbetsområdet Rapporter i CareLink™ Prokan du 

överföra uppgifter som hämtats från en enhet till kliniskt 

användbar information. I Om rapporter, på sidan 53 anges vilka 

slags rapporter du kan sammanställa. 

Rapporter kan genereras på skärmen, skickas direkt till en skrivare 

eller sparas som TIFF- eller PDF-filer som du kan bifoga till en 

Electronic Medical Record (EMR). Du kan generera flera olika slags 

rapporter genom en enda åtgärd.

De uppgifter som visas i dessa rapporter hämtas från patientens 

enheter, från hans/hennes CareLink Personal-konto eller från 

båda. 

Innan du börjar

Om du vill visa uppgifterna från en viss tidsperiod i en rapport 

måste du hämta uppgifterna om den perioden från patientens 

enhet. Det kan även hända att patientens enhet måste anslutas till 

datorn för att hämta aktuella uppgifter innan det går att skapa 

rapporter.
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Kontrollera uppgifterna under steget Verify Report Settings (bekräfta 

rapportinställningar) innan du skapar en rapport. Där kan du fin-

justera en rapport så att du får fram just de patientuppgifter som du 

vill ha.

Skapa rapporter       

I de följande avsnitten beskrivs de steg som måste utföras för att 

skapa en eller fler rapporter.

Öppna arbetsområdet Rapporter      

1 Klicka på patientfliken eller knappen OPEN PATIENT och dubbel-

klicka på patientens namn.

Arbetsområdet Reports visas (se exemplet på sidan 11).

OBSERVERA: Klicka på
SYNC DATA för att

säkerställa att du får
de senaste uppgifterna

om enheten från
patientens CareLink

Personal-konto.

Välja rapporteringsperiod        

1 Om du vill ändra hur lång tid rapporten/rapporterna ska omfatta 

klickar du på nedrullningsmenyn Duration och väljer en tidslängd. 

(Den längsta tidsperioden är 12 veckor.)

2 Från-och-med- och till-och-med-datum ställs in automatiskt om du 

inte väljer alternativet custom date range (anpassa datumintervall).

OBSERVERA: Om du
väljer en tidsperiod

som är längre än den
längsta tillåtna visas

ett felmeddelande.
Ändra tidslängden eller

datumen.

Om du vill ställa in datumen själv ska du klicka på nedrullnings-

menyerna för From eller Through och sedan välja månad, datum 

eller år. 

Kalender

Kalenderområdet i arbetsområdet Reports visar ett fönster på tre 

månader för rapportering av information. Där listas enheter och 

dessutom visas det hur mycket uppgifter det finns om enheten för de 

angivna tre månaderna. Dessutom anges rapporteringsperiodens 

längd för de tre markerade månaderna.

Öppna patient-
knapp
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Överlappningar mellan uppgifter från enheten och rapporterings-

perioden innebär att det finns uppgifter för några eller alla de 

rapporteringsperioder som visas.

Kalenderområdet visar inledningsvis de senaste tre månaderna. Om 

du vill se andra månader ska du klicka på piltangenterna i början 

eller slutet av perioden.

Välj uppgifter som ska finnas med       

1 Om patienten har en BG mätare som är länkad till deras pump, klicka 

för att välja ett av de följande alternativen för rapportering av 

mätaruppgifterna: 

– från pumpen: Fördelar med det här alternativet är bland annat 
att du bara behöver läsa av uppgifter från patientens pump, 
blodsockervärdena tidsstämplas av pumpen och värdena kopplas 
direkt till den bolusberäkning som använts. En nackdel är att om 
det uppstår kommunikationsproblem mellan pumpen och den 
länkade mätaren så kan det hända att blodsockervärdena för den 
perioden inte rapporteras. Dessutom kan det, om patienten har 

uppgifter om enheten
rapporteringsperiod

kalender
månad

Överlappning mellan uppgifter från 
enheten och rapporteringsperioden

piltangenter
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en MiniMed Paradigmpump äldre än 522/722, hända att de 
blodsockervärden från Bolusguideberäkningarna som inte lett till 
förändringar inte rapporteras.

– från länkad/länkade mätare: Fördelen med det här alternativet 
är att alla värden som sparats i den länkade mätaren rapporteras. 
Nackdelen är att du måste kontrollera att pumpen och mätarens 
klockor var synkroniserade för att kunna samordna uppgifter från 
mätaren och pumpen. Det kan alltså hända att du måste läsa av 
uppgifter från pumpen och den länkade mätaren separat.

2 Markera rutan bredvid enheten om du vill att uppgifter från enheten 

ska tas med i rapporterna. 

Det går inte att lägga till enheter som undantogs vid valet under 

steg 1. Om du vill ändra detta ska du välja det andra länkade 

mätaralternativet.

3 Avmarkera rutan bredvid enheten om du inte vill att uppgifter från 

den enheten ska tas med i rapporterna. 

Det går inte att avmarkera enheter som togs med vid valet under 

steg 1. Om du vill ändra detta ska du välja det andra länkade 

mätaralternativet.

Kontrollera om det finns data i enheten        

1 Se efter i kalenderområdet i arbetsområdet Reports om 

rapporteringsperioden överlappar uppgifter i enheten (se exemplet 

på sidan 46).

2 Om det finns överlappningar för hela rapporteringsperioden finns det 

uppgifter för din(a) rapport(er). I så fall kan du klicka på NEXT och 

gå till Bekräfta rapportinställningarna, på sidan 49.

3 Om det inte finns någon överlappning, eller om överlappningen inte 

är tillräcklig, finns det några alternativ:

– Justera rapporteringsperioden (se Välja rapporteringsperiod, på 
sidan 45).

– Hämta ytterligare uppgifter från enheten (se Hämta ytterligare 
uppgifter från enheten, på sidan 47).

Hämta ytterligare uppgifter från enheten        

1 Klicka på knappen READ DEVICE (avläs enheten) som hör till en viss 

enhet om du vill ha mer uppgifter från den.

Fältet för avläsning av enheten visas.
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VARNING: Annullera eller slutför alla temporära basaldoser eller aktiva bolusar och radera 
alla aktiva alarm. Pumpen stoppas under avläsningen. Kontrollera att pumpen startar igen 
efter att avläsningen har slutförts.

VARNING: Använd inte fjärrkontrollen då pumpen avläses. 

Om pumpbatteriet nästan är tomt skickar pumpen inte några uppgifter till datorn. Byt ut 
batteriet om enhetens statusskärm anger att batteriet är nästan tomt.    

2 Kontrollera att uppgifterna i fältet Choose port är de rätta för den 

här enheten. 

Om du vill ändra inställningen ska du klicka på nedrullningsmenyn för 

fältet och välja en annan inställning.

3 Kontrollera att enheten är ansluten till din dator. 

4 Om enheten är en pump kan du specificera hur många uppgifter du 

vill ha från den. Klicka på nedrullningsmenyn Amount of Data och 

välj en mängd.

OBSERVERA: Om du
väljer All available data,

(alla tillgängliga
uppgifter) läser

systemet av alla
uppgifter från pumpen.

Därmed skrivs alla
dubbla uppgifter i

systemet över.

5 Klicka på READ DEVICE. Läs noggrant det meddelande som visas 

eftersom det ger specifika instruktioner för hur pumpen ska läsas av.

6 Följ instruktionerna och klicka på OK. 

Förloppsindikatorn för avläsning av enheten visas.

Du kan när som helst annullera avläsningen genom att klicka på 

CANCEL.

Ett bekräftelsemeddelande om att avläsningen är klar visas.

7 Klicka på OK.

Uppgifterna från enheten visas nu i uppgiftskalendern.

8 Klicka på NEXT överst i arbetsområdet Reports.

Steget för bekräftelse av rapportinställningarna visas. Det gör att du 

kan kontrollera att inställningarna för den här patienten är korrekta 

innan du kör rapporterna.

Fältet READ DEVICE

knapp för AVLÄSNING 
AV ENHETEN
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Bekräfta rapportinställningarna           

1 Kontrollera att inställningarna för blodsockermålet är korrekta. För 

in de rätta värdena eller klicka på pilarna upp eller ned i fälten Low

eller High för att höja eller sänka värdena.

OBSERVERA: Du kan ha
upp till fem

måltidsperioder.
Standardinställningen
är frukost, lunch och

middag.

2 Klicka på ADD MEAL för att lägga till en ny måltidsperiod. Klicka var 

som helst på tidslinjen inom en av måltidsperioderna för att redigera 

en befintlig måltidsperiod.

Fönstret för redigering av måltidsperioderna, som visas under 

tidslinjen, öppnas.

3 För in text eller klicka på pilarna för att välja de inställningar du vill 

ha.

OBSERVERA: Om du
bara vill använda

inställningarna för den
här måltiden ska du

avmarkera rutan
bredvid Use these

parameters for all of this
patient’s meals (Använd

dessa parametrar för
alla den här patientens

måltider).

– Meal Name: det namn du vill ge måltidsperioden.

– Meal Time Period: timmar då måltiden intas.

– Pre-Meal BG Target (gränsvärden för blodsocker före måltid, 
mg/dl eller mmol/l): lägsta och högsta gränsvärdena för 
patientens blodsockervärde före måltiden.

– Pre-Meal Analysis Period: den tidsperiod som blodsockret 
analyseras före en måltid. Blodsockervärdena från den här tiden 
används i detaljerade rapportanalyser.

tidslinje

måltidsperiod 

fält för redigering av måltidsperioderna

sänggående och uppvaknande
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– Post-Meal BG Target (gränsvärden för blodsocker efter måltid, 
mg/dl eller mmol/l): lägsta och högsta gränsvärdena för 
patientens blodsockervärde efter måltiden.

– Post-Meal Analysis Period: den tidsperiod som blodsockret 
analyseras efter en måltid. Glukosvärdena från den här tiden 
används i detaljerade rapportanalyser.

OBSERVERA:
Måltidsperioder kan

inte överlappa
varandra, men start-
och slutlinjerna kan

gränsa till varandra.
Måltidsperioderna
måste vara minst
60 minuter långa.

Du kan ändra längden på en befintlig period för måltider, upp-

vaknande och läggdags genom att klicka på start- eller slutlägena 

och sedan dra perioderna längs tidslinjen. 

4 Om du vill använda de här måltidsinställningarna för alla patientens 

måltider ska du markera rutan bredvid Use these parameters for all 

of this patient’s meals.

5 Klicka på SAVE efter att du har skapat eller redigerat en måltids-

period.

6 Ta bort en måltidsperiod genom att klicka på DELETE MEAL. Klicka på 

DELETE när du uppmanas att bekräfta.

7 CareLink Pro kommer ihåg dessa inställningar för patienten nästa 

gång du kör en rapport för honom eller henne. Klicka på SAVE 

SETTINGS för att spara dem för den här patienten.

8 Klicka på NEXT överst i arbetsområdet Reports.

I det här steget kan du välja och generera rapporter. Du kan välja en 

lista med rapporttyper eller en datatabell som hjälper dig att välja 

att ta med eller utelämna uppgifterna från vissa dagar i Daily Detail-

rapporterna. 

välj start- eller slutläge, dra längs och släpp på tidslinjen

tidslinje

markörer för mätaravläsningar



CareLink™ Pro Bruksanvisning   Rapporter      51

9 Klicka på utskriftsikonen för att skriva ut innehållet på skärmen.

OBSERVERA: Klicka på
>>customize columns om

du vill ändra hur
datatabellen visas. Se

Preferenser för
rapportgenerering, på

sidan 22.

Välja rapporttyper och datum som ska omfattas           

1 Markera rutan bredvid de rapporter du vill ska ingå i rapport-

uppsättningen.

2 Om uppgifter har lästs av från en pump eller Guardian-monitor mer 

än en gång under rapporteringsperioden kan det finnas flera 

snabböversikter över pumpinställningarna: 

a. Kontrollera att rutan bredvid Device Settings Snapshot 
(snabböversikt enhetsinställningar) har markerats. 

b. Klicka på pilen i datumfältet och välj datum och tid för en 
snabböversikt.

– Pumpar: Välj en snabböversikt över patientens pump.

– Guardian: Välj en snabböversikt över patientens Guardian-
monitor. 

Om något fält är skuggat finns det inga snabböversikter för 

rapporteringsperioden.

3 Bläddra igenom datatabellen för att granska den tillgängliga Daily

Detail-rapportinformationen. 

– Du kan sortera uppgifterna i varje kolumn. Klicka på kolumn-
rubriken för att sortera uppgifterna i stigande ordning. Klicka på 
rubriken igen för att sortera uppgifterna i fallande ordning.

Datatabell

utskriftsikon
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OBSERVERA: Om det
inte finns några

uppgifter för ett visst
datum går det inte att

välja det.

4 Markera rutan vid datatabellraderna för de datum du vill ha en Daily 

Detail-rapport över. 

– Du kan ta med eller ta bort alla datum för Daily Detail-rapporter 
genom att markera eller avmarkera rutan över alla markerings-
rutor för datum i datatabellen.

Generera rapporter                                 

1 När du har bekräftat valen för rapporter ska du klicka på GENERATE 

REPORTS överst i arbetsområdet Reports.

En lista med alternativ.

2 Välj hur du vill förhandsvisa, skriva ut eller spara rapporter.

Om du väljer Preview, visas fönstret Report Preview.

3 Klicka på pilarna för att navigera genom rapporter på flera sidor.

4 Klicka på någon av de andra knapparna överst i fönstret Report 

Preview för att spara eller skriva ut rapporterna.

5 Stäng fönstret genom att klicka på knappen CLOSE i fönstrets övre 

högra hörn.CLOSE
knapp
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Om rapporter         

I detta avsnitt beskrivs de olika rapporterna. Mer information om 

rapportkomponenterna och provrapporter finns med i Report 

Reference Guide (guiden för referensrapporten). Du kommer till 

Report Reference Guide genom CareLink Pro-programvaran:

1 Help > View Report Reference Guide (PDF).

2 Välj ett språk för Report Reference Guide.

CareLink Pro-rapporterna har följande gemensamt: 

• Rubrik — I rubriken finns information som identifierar rapporten, som 

rapportens namn, patientens namn och varifrån uppgifterna kommer.

• Kolhydrater och blodsockervärden — Kolhydratenheterna visas 

kursivt och blodsockervärdena visas i fetstil i kurvor och tabeller.

• Helguppgifter — Helgdagarna är i fetstil så att det går lätt att hitta 

dem.

• Symbolförklaringar — En lista med symboler visas längst ned på varje 

rapport. Även om symbolerna används i flera olika rapporter så är 

symbolförklaringarna unika för varje rapport.

Responsrapport        

Den här rapporten visar data som beskriver hur insulinpumpar och 

sensorer används och patientens beteende som är av betydelse för 

behandlingen. Den besvarar frågan "Fanns det tillräckligt med 

uppgifter för att ge en riktig bild av hur patienten använder sin 

insulinpump och sensor, om detta är relevant". Den besvarar också 

frågan "Håller patienten sig till behandlingen enligt givna 

instruktioner?" Rapporten visar på om du behöver prata med 

patienten om hur han eller hon sköter sin diabetes.

Sensor- och mätaröversiktsrapport        

Sensor- och mätaröversiktsrapporten visar grafiskt patientens dagliga 

blodsockermätarvärden och genomsnittsvärden, inklusive uppgifter 

per timme över hela dygnet och hur värdena ligger i förhållande till 

måltids- och sömnmönster. Dessutom ingår statistik om patientens 

blodsockervärden och insulindosering. 

En analys av sensordata genereras på samma sätt som förstasida i 

denna rapport om sensordata finns tillgängliga. Om inga sensordata 

finns kommer uppgifterna från mätaren att genereras som förstasida.
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Rapportens sista sidor visar nivåerna dag för dag och kvaliteten på 

patientens glykemiska, kolhydrat- och insulinkontroll. På varje sida 

visas hur kontrollen varierar dag för dag under hela rapporterings-

perioden med maximalt 14 dagar per sida.

Loggboksrapport        

Loggboksrapporten visar mätarblodsocker samt kolhydrat- och 

insulindata för varje dag under rapporteringsperioden. Resultat visas 

varje timme för timme, såväl som dagliga medelvärden och total-

summor. Varje sida innehåller upp till 14 dagar. Om rapporterings-

perioden överstiger 14 dagar genereras extra sidor.

Snabböversikt över enhetsinställningar        

Den här rapporten ger en snabböversikt över patientens pump- eller 

Guardian REAL-Time monitorinställningar vid ett specifikt datum och 

en specifik tidpunkt. Den kan hjälpa dig att förstå andra rapporter 

eller helt enkelt dokumentera patientens inställningar. 

Pump- eller monitorinställningarna registreras bara när enheten läses 

av. Om enheten inte avlästes under rapporteringsperioden finns inga 

inställningar tillgängliga.

Daglig detaljrapport        

Den dagliga detaljrapporten visar glukosdata, kolhydratmängder samt 

patientens insulinanvändning under en vald dag. En separat rapport 

genereras för varje dag som valts i datatabellen.

Daily Detail-rapporten ger en detaljerad översikt över alla dagar som 

valts. Den gör att du kan fokusera på en viss dag om något av vikt för 

patientens behandling kan ha inträffat.

Exportera data          

Du kan exportera data från enheten som hämtats och lagrats av 

CareLink Pro. Den ger dig alla uppgifter från patientens enhet så att 

du kan använda dem för statistiken eller för att skapa special-

rapporter eller diagram. Filen (.csv) kan importeras till Microsoft 

Excel eller till vissa kliniska statistikprogram där uppgifterna kan 

bearbetas ytterligare.
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Filen (.csv) innehåller uppgifter om enhetens aktiviteter. Den listar 

till exempel registrerade mätarvärden, att pumpen fått ett värde från 

mätaren eller ändringar av basaldosen.

OBSERVERA: Det är en
avancerad funktion som
kräver att du känner till

de rena uppgifterna
från enheten. Dessutom

måste du vara bekant
med den programvara

till vilken du importerar
.csv-filen.

Följ dessa instruktioner för att använda CareLink Pros exportfunktion:

1 Klicka på patientfliken eller knappen OPEN PATIENT och 

dubbelklicka på patientens namn.

2 Kontrollera att arbetsområdet Reports visas.

3 Ställ in datum och rapportlängd i fälten Duration eller Från-och-

med/Till-och-med.

Den längsta period du kan välja är 12 veckor.

4 Klicka på länken export selected data (exportera valda uppgifter).

Dialogrutan för export av data till csv-fil visas.

5 Om du vill ändra var csv-filen ska sparas på din dator ska du klicka på 

pilen till höger om fältet Save in och välja en plats.

6 Om du vill ändra filens namn ska du skriva in det i rutan File name.

7 Klicka på SAVE.

OBSERVERA: Mer
information om de

uppgifter som visas i
csv-filer finns under

CSV-data, på sidan 65.

Nu har .csv-filen sparats på dator, där du valt att den ska sparas. Om 

du vill kan du välja att importera den till ett program som stöttar 

den här filtypen.

länken exportera 
valda uppgifter
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Systemadministration 8

Vad innehåller det här kapitlet?
• Innan du börjar: sida 56

• Programvaruuppdateringar: sida 57

• Säkerhetskopia och återställande av databasen: sida 58

Det är väldigt viktigt att du regelbundet gör en säkerhetskopia av 

CareLink™ Pro databas. I databasen sparas alla systemuppgifter 

som samlats i patientens journaler, inklusive information om 

profilen, uppgifter som härletts från enheten och rapport-

inställningar. 

CareLink Pro låter dig spara kopior av databasen och återställa 

den.

Det är också viktigt att du har den senaste versionen av CareLink 

Pro. Versionerna uppdateras regelbundet och kan innehålla viktiga 

förbättringar. Du kan antingen välja att leta efter uppdateringar 

eller få ett meddelande om när de är tillgängliga.

Innan du börjar

Det är en bra idé att ha ett regelbundet schema för säkerhets-

kopiering av databaserna. På så sätt är du säker på att det görs 

regelbundet och därmed minskar risken för att uppgifter går 

förlorade. 

Under en säkerhetskopiering eller ett återställande detekterar 

CareLink Pro andra användare som kanske använder programmet 
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på andra datorer och ger dem en möjlighet att spara sina arbeten. Vi 

rekommenderar dock att kontrollera om andra användare arbetar på 

systemet innan processen inleds.

Programvaruuppdateringar         

Automatiska uppdateringar

Vid olika tillfällen kommer programvaran till CareLink Pro att 

uppdateras. Gör så här när du får ett meddelande om att det finns en 

uppdatering.

OBSERVERA: Gör en
säkerhetskopia av

databasen innan
programvaran

uppdateras. Se
Säkerhetskopia av en
databas, på sidan 58.

1 Kontrollera att din dator har en aktiv Internetanslutning.

2 Programmet visar ett uppdateringsmeddelande när det finns en 

uppdatering av CareLink Pro. Du kan då välja att ladda hem 

uppdateringen.

3 Klicka på DOWNLOAD. (Om du klickar på CANCEL stängs 

meddelandet om uppdatering. Du kan ladda hem uppdateringen vid 

ett senare tillfälle.)

Ett varningsmeddelande visas som rekommenderar dig att ta en 

säkerhetskopia på din databas.

4 Klicka på YES för att skapa en säkerhetskopia av databasen (se 

Säkerhetskopia av en databas, på sidan 58 för proceduren). Klicka 

på NO om du inte vill göra någon säkerhetskopia.

Ett meddelande visas som bekräftar att den nya versionen av 

CareLink Pro har laddats ner.

5 Klicka på YES för att stänga och öppna programvaran på nytt om du 

vill börja använda den senaste versionen av CareLink Pro. Klicka på 

NO om du hellre vill vänta innan du startar om CareLink Pro.

Avstängning av automatiska uppdateringar

Gör så här om du inte vill få något automatiskt meddelande om 

uppdateringar av CareLink Pro:

1 Välj Tools > Options.

2 Klicka på fliken General.

3 Avmarkera rutan bredvid Automatically check for software updates

under Communications.
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Manuell kontroll av uppdateringar

Du kan när som helst manuellt kontrollera om det finns några 

CareLink Pro-uppdateringar.

OBSERVERA: Gör en
säkerhetskopia av

databasen innan
programvaran

uppdateras. Se
Säkerhetskopia av en
databas, på sidan 58.

1 Kontrollera att din dator har en aktiv Internet-anslutning.

2 Välj Tools > Check for Software Updates

3 Om det inte finns några uppdateringar tillgängliga visas ett 

meddelande om detta. Om det finns en uppdatering visas ett 

meddelande om CareLink Pro-uppdatering. 

4 Följ procedurerna under Automatiska uppdateringar, på sidan 57.

Säkerhetskopia och återställande av databasen

Säkerhetskopia av en databas     

Gör så här för att göra en säkerhetskopia av databasen.

1 Kontrollera att alla patientjournaler är stängda.

2 Välj Tools > Backup Database.

OBSERVERA:
Säkerhetskopior kan

sparas på en
nätverkshårddisk eller

på ett flyttbart
lagringsmedium (DVD,

CD, USB-enhet osv.)

3 Om du vill spara en säkerhetskopia på en annan plats på din dator 

ska du klicka på pilen till höger om fältet Save in och välja en ny 

plats.

4 Om du vill ändra filens namn ska du skriva in det i rutan File name.

5 Klicka på SAVE. En förloppsindikator visas medan databasen sparas.

En meddelande visas när säkerhetskopieringen är klar.

6 Klicka på OK för att stänga meddelandet.

Återställa en databas      

Det kan hända att databasen måste bytas ut om den inte längre kan 

öppnas eller användas.

VARNING: När du byter ut den mot en säkerhetskopia går alla uppgifter som skapats efter 
den valda säkerhetskopian förlorade.

Gör så här för att välja en säkerhetskopia som ska ersätta den 

aktuella databasen.

1 Kontrollera att alla patientjournaler är stängda.

2 Välj Tools > Restore Database.

3 Välj den säkerhetskopia du vill använda för att ersätta den aktuella 

databasen (oftast den senaste).
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4 Klicka på OPEN. Ett varningsmeddelande visas. Klicka på OK.

5 En förloppsindikator visas medan databasen återställs.

Ett meddelande visas när databasen har återställts.

6 Klicka på OK för att stänga meddelandet.

Om systemet inte är tillgängligt                

Om du försöker starta systemet medan en annan användare 

säkerhetskopierar eller utför en återställning, visas ett meddelande 

om att systemet inte är tillgängligt. Du kan inte använda systemet 

förrän uppgiften är klar.

Gör något av följande:

• Vänta tills processen är färdig och systemet är tillgängligt igen.

• Klicka på CANCEL för att avsluta och försöka igen senare.
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Felsökning 9

Vad innehåller det här kapitlet?
• Allmänna fel: sida 60

• Fel vid avläsning av enheten: sida 61

• Fel då rapporten skapas: sida 62

• Säkerhetskopierings- och återställningsfel: sida 63

• Avinstallera programvaran: sida 63

Det här kapitlet hjälper dig att lösa problem som kan uppstå då du 

använder programvaran till CareLink™ Pro. Dessutom innehåller det 

instruktioner om hur programvaran till CareLink Pro ska 

avinstalleras om det skulle behövas.

Allmänna fel

Rätt att hämta uppdateringar av programvaran från Internet

Om du försöker hämta en uppdatering av programvaran från 

Internet kan det hända att du får ett meddelande om att du inte 

är auktoriserad att göra det. Du måste ha administratörsstatus för 

att få hämta uppdateringar av programvaran till CareLink Pro.

1 Stäng CareLink Pro och starta om datorn. 

2 Be någon med administratörsstatus logga in på datorn.

3 Följ instruktionerna under Programvaruuppdateringar, på 

sidan 57.
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Inte ansluten till databasen

Ett felmeddelande som anger att du inte är ansluten till databasen 

innebär något av följande:

• Databasen har flyttats. Databasen måste vara på samma plats som 

valdes då programvaran till CareLink Pro installerades. Om den har 

flyttats måste den flyttas tillbaka till den plats som valdes under 

installationen.

• Du är inte ansluten till den nätverksstation där databasen ligger. Om 

databasen ligger på en nätverksstation kan det hända att nätverket 

har vissa problem som gör att du inte kan komma åt stationen. Du är 

inte ansluten till den nätverksstation där databasen ligger. 

Glömt klinikens lösenord till CareLink Pro

Om ingen kommer ihåg det lösenord som kliniken använder för att 

logga in till CareLink Pro måste CareLink Pro installeras på nytt och 

en ny databas skapas. När du har ominstallerat programvaran kommer 

du inte åt någon patientinformation i den föregående databasen. 

Lagra lösenordet som du skapade under den nya installationen på en 

säker plats så att inga framtida uppgifter går förlorade. 

Fel vid avläsning av enheten

Fel vid avläsning av enheten Förklaring

Den seriella port som valdes 
kan inte öppnas. Det kan 
hända att en annan handling 
utförs på den porten. Vänta 
tills porten blir ledig eller 
välj en annan port.

Bekräfta att kommunikationsporten inte används 
av något annat program eller välj en annan port. 
Försök att starta om datorn och sedan försöka 
läsa av igen. Det kan vara något fel på den 
maskinvara (kabel etc.) som anslutits till porten 
eller ett fel på själva porten. Anslut maskinvaran 
till en annan port och försök läsa av enheten 
igen, för att avgöra om det var problemet. 

Auto Detect hittade inte 
enheten på någon tillgänglig 
port. Kontrollera kabel-
anslutningen, enhetens 
batteri & status och försök 
igen, eller försök specificera 
en seriell port.

Kontrollera anslutningen mellan kabeln och 
datorn samt att batteriets status är OK. Om dessa 
är bra, pröva att specificera den seriella port på 
datorn som kabeln anslutits till, i stället för att 
välja Auto Detect.

Enheten hittas inte i den 
seriella port som valts. 
Kontrollera kabel-
anslutningen, enhetens 
batteri & status och försök 
igen, pröva med att 
specificera en annan port 
eller pröva med Auto Detect.

Kontrollera anslutningen mellan kabeln och 
datorn samt att batteriets status är OK. Om dessa 
är bra, pröva antingen att välja en annan seriell 
port på datorn eller välj alternativet Auto Detect.
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Fel då rapporten skapas

Flera uppgifter för samma datum

Om det finns flera uppgifter för samma datum och tid för samma 

enhet så betraktar systemet det som en konflikt som inte kan lösas. 

Rapporter som skapas med dessa uppgifter utelämnar den del av 

uppgifterna som överlappar varandra. 

Du kan försöka anpassa rapporteringsperioden så att de överlappande 

uppgifterna utelämnas. Eller så kan du ta bort enheten från systemet 

och sedan lägga till den igen så att de tidigare avläsningarna raderas.

Kan inte kommunicera med 
enheten. Kontrollera att du 
har satt i och valt rätt enhet, 
kontrollera kabel-
anslutningen, enhetens 
batteri och status och försök 
igen.

Kontrollera alla inställningar som valts för 
avläsning av enheten, inklusive enhetens namn, 
serienummer och typ av anslutning. Kontrollera 
även att enheten, kablarna och datorn är 
anslutna på rätt sätt. Kontrollera att enhetens 
batteri- och alarmstatus är OK. Försök läsa av 
igen.

Oväntad respons... försöker 
igen (n%)

Ett oväntat värde lästes av från enheten. 
Systemet försöker återuppta kommunikationen 
tills det att du annulerar eller tills 
kommunikationen lyckas.

Kommunikationsenheten 
hittades, men pumpen 
(<serienummer>) svarar inte. 
Kontrollera pumpens 
serienummer, placera 
pumpen närmare 
kommunikationsenheten för 
att minimera störningar, 
kontrollera pumpens batteri 
och status.

Kontrollera att rätt serienummer förts in för 
pumpen. Om inte, för in rätt serienummer. Om 
serienumret är korrekt kan du försöka flytta 
pumpen närmare kommunikationsenheten eller 
flytta kommunikationsenhet och pump längre 
bort från möjliga störningskällor (som t.ex. andra 
RF-enheter), eller kontrollera pumpens batteri 
och doseringsstatus.

Pumpen doserar en temporär 
basaldos. Annulera den 
temporära basalen eller 
vänta tills den är slutförd 
och försök sedan på nytt.

Den pump du försöker läsa av doserar en 
temporär basaldos. Vänta antingen med att 
avläsa pumpen tills den temporära basaldosen är 
avslutad eller annulera den temporära basaldosen 
och läs sedan av pumpen.

Pumpen har aktiva fel eller 
alarm. Radera alarmen och 
försök på nytt.

Det finns aktiva alarm på pumpen som gör att den 
inte kan läsas av. Läs igenom alarm-
instruktionerna och radera alarmet. Radera 
alarmet och försök läsa av pumpen på nytt.

Pumpen doserar en bolus. 
Annulera bolusen eller vänta 
tills den är slutförd och 
försök sedan på nytt.

Den pump du försöker läsa av doserar en bolus. 
Vänta antingen med att avläsa pumpen tills 
bolusen är avslutad eller annulera bolusen och läs 
sedan av pumpen.

Enheten skickar ogiltiga 
uppgifter; alla avlästa 
uppgifter kasseras.

Kontakta er Medtronic-representant (se Hjälp, på 
sidan 3).

Fel vid avläsning av enheten Förklaring
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Systemet kommer att ignorera uppgifterna

Om tiden på en enhet har ändrats så att det ger överlappningar eller 

utelämnade uppgifter på tre timmar eller mer tar inte systemet med 

dessa uppgifter då rapporterna skapas.

Säkerhetskopierings- och återställningsfel

Databasen kan inte låsas

Det innebär att du använder systemet i en miljö med flera användare 

och att andra användare var inloggade. Systemet tillåter inte en 

säkerhetskopiering av databasen samtidigt som andra användare kan 

utföra uppgifter som kan påverka databasen. Efter att alla andra 

användare har lämnat CareLink Pro kan du göra en säkerhetskopia.

Säkerhetskopieringen eller återställandet av databasen slutförs inte

Andra användare kan inte logga in och säkerhetskopieringen eller 

återställandet kan inte slutföras. Kontakta produktsupporten eller er 

Medtronic-representant (se Hjälp, på sidan 3).

Återställandet av databasen misslyckas

Det är något fel på den säkerhetskopia av databasen som du försöker 

använda för återställandet. Försök återställa med en annan 

säkerhetskopia.

Avinstallera programvaran

Gör så här för att avinstallera CareLink Pro:

1 Öppna menyn Control Panel through your Windows Start.

2 Välj Add or Remove Programs. Fönstret Add or Remove Programs 

visas.

3 Bläddra ner till Medtronic Carelink Pro och klicka på den.

4 Klicka på REMOVE. Installationsguiden visas.

5 Klicka på NEXT. Ett meddelande visas som ber dig bekräfta att du vill 

ta bort programmet.

6 Klicka på YES. Avinstallationsprogrammet körs och tar bort 

programmet och alla dess filer från din dator. När det är klart visas 

ett meddelande på skärmen som bekräftar avinstallationen.

7 Klicka på FINISH.
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Symboltabell
Ikonerna och symbolerna på förpackningsetiketten och utrustningen 

beskrivs i följande tabell.

Beskrivning Ikon

En per behållare/förpackning (1x)

Obs: Se bruksanvisningen

CD medföljer

Viktiga dokument bifogade

Referensnummer REF

CE-märkning av anmält organ som 
medicinteknisk produkt
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Bi
la

ga
 A

CSV-data A

I denna bilaga beskrivs de CareLink™ Pro-uppgifter som visas vid 

export till CSV-format. 

Definition av kolumnerna

Kolumnrubrik Definition

Index Den ordning i vilken uppgifterna registrerades i 
enheten.

Date (Datum) Den ordning i vilken datumen registrerades i 
enheten.

Time (Tid) Den ordning i vilken tiden registrerades i 
enheten.

New Device Time 
(Ny tid i enheten)

Det nya datumet och den nya tiden om det har 
ändrats i enheten.

BG Reading (mg/dl or 
mmol/l) 
(BS-värde (mg/dl eller 
mmol/l))

Det blodsockervärde som registrerats av mätaren, 
Guardian eller pumpen. Om uppgifterna kommer 
från en pump eller Guardian, är värdena i 
kolumnen manuella BS-värden och BS-värden från 
en Link-mätare. 

Linked BG Meter ID 
(ID för länkad BS-mätare)

Serienumret på den mätare som skickar ett visst 
blodsockervärde till enheten.

Basal Rate (U/h) 
(Basaldos (E/tim))

Den aktiva basalinsulindosen i enheter per 
timme.

Temp Basal Amount 
(Temp basalmängd) 

Om en temporär basaldos användes i pumpen 
anger det här värdet Temp Basal Amount (Temp 
basalmängd). 

Temp Basal Type 
(Temp basaltyp)

Typ av temporär basaljustering (insulindos eller 
procent av basaldosen).

Temp Basal Duration (m) 
(Temp basal varaktighet (m))

Tidslängden i minuter för den temporära basal-
insulindoseringen (se typen ovan).

Bolus Type (Bolustyp) Doseringstyp för bolusinsulin [normal, förlängd, 
dubbel (normal del) eller dubbel (förlängd del)].
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Bolus Volume Selected (U) 
(Vald bolusvolym (E))

Antalet insulinenheter som valts att doseras 
under bolusinsulindosering.

Bolus Volume Delivered (U) 
(Doserad bolusvolym (E))

Antalet insulinenheter som verkligen doseras 
under bolusinsulindosering.

Programmed Bolus Duration 
(h) 
(Programmerad 
bolusvaraktighet (tim))

Varaktighet för förlängd bolus eller den förlängda 
delen av en dubbel bolus.

Prime Type (Primetyp)

Manuell eller fast. Manuell används omedelbart 
efter en återställning, för att fylla infusionssetet 
med insulin innan det sätts in. Fast används efter 
att infusionssetet satts in för att fylla den mjuka 
kanylen med insulin efter att mandrängen har 
tagits ut.

Prime Volume Delivered (U) 
(Doserad primevolym (E))

Antalet insulinenheter som verkligen doseras för 
primen.

Alarm Namnet på det alarm som gått.

Suspend (Stoppa) Identifierar pumpens stoppstatus.

Rewind (Återställ pump) Datum och tid för återställning av enheten.

BWZ Estimate (U) 
(Bolusguide beräkning (E))

En uppskattning av bolusinsulinet om det 
beräknats med funktionen bolusguide på 
Paradigm-pumpen.

BWZ Target High BG (mg/dL 
or mmol/L) 
(Bolusguide högt BS (mg/dl 
eller mmol/l))

Inställningen för det högre gränsvärdet för blod-
socker, som används av bolusguidefunktionen.

BWZ Target Low BG (mg/dL 
or mmol/L) 
(Bolusguide lågt BS (mg/dl 
eller mmol/l))

Inställningen för det lägre gränsvärdet för blod-
socker, som används av bolusguidefunktionen.

BWZ Carb Ratio 
(Bolusguide kolh.kvot)

Inställning för insulin-kolhydratkvoten. Om 
enheten gram används är denna kvot mängden 
kolhydrater i gram som täcks av en enhet insulin. 
Om enheten utbyten används är denna kvot det 
antal insulinenheter som används för att täcka ett 
kolhydratutbyte.

BWZ Insulin Sensitivity 
(Bolusguidens 
insulinkänslighet)

Inställningen för insulinkänslighet. Insulin-
känsligheten är den mängd blodsockervärdet 
minskas med av en enhet insulin. Detta används 
av bolusguidefunktionen.

BWZ Carb Input 
(Bolusguide kolh.kons.)

Mängd kolhydrater som anges i bolusguiden och 
används för att beräkna bolus.

BWZ BG Input (mg/dL or 
mmol/L) 
(Bolusguide BS-inmatn. 
(mg/dl eller mmol/l))

Blodsockervärde som anges i bolusguiden och 
används för att beräkna bolus.

BWZ Correction Estimate (U) 
(Bolusguide korrektions-
beräkning (E))

Antal enheter bolusinsulin som ska ges för att 
korrigera blodsockervärdet, beräknat av 
bolusguiden.

BWZ Food Estimate (U) 
(Bolusguide matberäkning 
(E))

Antalet enheter bolusinsulin för att täcka det 
förväntade kolhydratintaget, beräknat av 
bolusguiden.

Kolumnrubrik Definition
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Mer om CSV-filer som exporteras av CareLink Pro

Titeln överst i en CSV-fil innehåller följande information:

• patientens namn

• en lista med valda enheter och deras serienummer

• valda datum

Varje block med kolumner har en titel som innehåller det följande:

• namnet på den enhet uppgifterna gäller för

• serienumret på den enheten 

Om uppgifterna inte visas som förväntat

Det är flera olika faktorer som kan göra att CSV-uppgifterna visas på 

ett annat sätt än förväntat.

• Ändringar av datum eller tid på enheten kan ändra sekvensen eller ge 

registreringar utanför det valda datumområdet.

• Om det finns en stor lucka mellan avläsningarna av enheten kan det 

hända att uppgifterna för den enheten visas i flera block.

BWZ Active Insulin (U) 
(Bolusguide aktivt insulin 
(E))

Mängden aktivt insulin som beräknats ska finnas 
kvar i kroppen från tidigare bolusinsulindoser när 
bolusmängden ska beräknas med funktionen 
Bolusguide.

Sensor Calibration BG 
(mg/dL or mmol/L) 
(Sensorkalibrering BS (mg/dl 
eller mmol/l))

Det BS-värde som används för kalibrering av 
sensorn i mg/dl eller mmol/l

Sensor Glucose (mg/dL or 
mmol/L) 
(Sensor-BS (mg/dl eller 
mmol/l))

Sensorglukosvärdet.

ISIG value (ISIG-värde) Ingångssignaler (ISIG), läses från sensorn och mäts 
i nanoampere (nA).

Kolumnrubrik Definition
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O
rd

li
st

a

Ordlista

A
A1C   Glykosylerat hemoglobin

A1C-test  Hemoglobin A1C-test, som används för att tolka 
blodsockervärdena under en tidsperiod.

B
Basaldos  Pumpinställning som ger löpande insulininfusion för att 
hålla blodsockret stabilt mellan måltiderna och under natten. Basalt 
insulin efterliknar bukspottkörtelns insulindosering vilket motsvarar 
kroppens icke-matrelaterade insulinbehov.

Basalinsulin  En kontinuerlig mängd insulin per timme som doseras 
automatiskt av insulinpumpen, grundad på förprogrammerade profiler 
för personliga doser som ställts in i pumpen. Pumpen doserar en 
daglig mängd insulin som normalt sett täcker "bakgrundsbehovet" av 
insulin under perioder med fasta (t.ex. nattetid och mellan 
måltiderna.

Basalprofil  En basaldos med en start- och en stopptid. Användaren 
kan programmera in flera olika profiler i sin pump, var och en med sin 
egen basaldos, under en 24-timmarsperiod, för att få bättre 
glukoskontroll.

Basalprogram  Användaren kan programmera upp till tre olika 
basalprogram i pumpen för dosering av basalinsulin: Standard, A och 
B. Varje program har möjligheten att ställa in upp till 48 basaldoser.

Bolusinsulin  En dos insulin som doseras för att täcka en förväntad 
höjning av blodsockret (som t.ex. höjningen efter en måltid eller ett 
mellanmål) eller för att sänka ett högt blodsocker ner till målvärdet.

BS  Blodsocker

C
CareLink™ Personal  En onlinetjänst som kan hantera diabetes-
uppgifter via Internet.
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CareLink™ USB  Enhet som används för att ladda ned data som lagrats 
i en Medtronic Diabetes Paradigm-insulinpump, eller 
Guardian REAL-Time-monitor, till CareLink™-programvaran via USB-
porten på datorn.

ComLink   En transceiver på radiofrekvens (RF) som används för att 
ladda ned data från en paradigmpump eller ett Guardian REAL-Time 
CGM-system till datorn.

Com-Station  En enhet som används för att hämta uppgifter från 
pumpen MiniMed 508 och vidarebefordra uppgifter från andra 
tillverkares mätare till datorn.

D
Dual Wave® (dubbel) bolus  En kombination av normal bolus som 
doseras omedelbart och därefter följs av en förlängd bolus. Förlängd 
bolus doserar jämnt under en period.

E
Expressbolus  En tillsatsmetod för valfri bolustyp som använder sig av 
pumpens express bolus-knapp.

F
Förlängd (Square Wave®) bolus  Bolus som avges jämnt under en 
användarspecificerad tidsperiod (30 minuter till 8 timmar). 

Förlängd del  Den andra delen i en dubbel bolus. Den förlängda delen 
doserar jämnt över en period sedan NU-delen doserats.

G
Genomsnittlig area under kurvan (AUC)  Genomsnittlig 
exponeringsmängd för hyperglykemi eller hypoglykemi för den period 
sensorn sände.

H
HbA1c   Glykosylerat hemoglobin

HbA1C-test  Hemoglobin A1c-test, som används för att tolka 
blodsockerkontrollen eller genomsnittet av värdena under en period 
på 2-3 månader.

Hyperglykemisk  Förhöjt blodsocker som upptäcks vid övervakningen 
av blodsockervärdena, med eller utan något eller alla av de följande 
symptomen: illamående, kräkningar, suddig syn, huvudvärk, orolig 
mage, att kissa ofta och stora mängder samt apati. 

Hypoglykemisk  Lågt blodsocker som upptäcks vid övervakningen av 
blodsockervärdena, med eller utan något eller alla av de följande 
symptomen: extrem hunger, skakningar elller darrningar, svettning, 
"dansande" syn, yrsel, huvudvärk, sluddrande tal, plötsliga 
humörbyten eller personlighetsförändringar.
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Högt BS  Pumpen utlöser ett alarm om sensorn indikerar att 
användarens sensorblodsocker är lika med eller över detta värde. Du 
kan aktivera eller inaktivera den här funktionen som du vill.

I
Infusionsset  Den apparat som används för att föra in och säkra en 
kanyl under huden och transportera insulin till insticksstället genom 
slangar från pumpen.

Insulinkoncentration  Styrkan eller typen av insulin som läkaren 
skrivit ut åt användaren. Detta påverkar den insulindos som pumpen 
doserar. Om användarens insulinkoncentration ändras måste 
basalprofilerna och de högsta basal- och bolusdoserna programmeras 
om i pumpen.

Insulinkänslighet  Hur mycket i mg/dl (eller mmol/l) din 
blodsockernivå (BS-nivå) förändras av en enhet insulin. 
(Bolusguidedata.)

K
Kalibreringspåminnelse   Tiden för kalibreringspåminnelsen kan 
ställas in efter eget val. Om kalibreringspåminnelsen till exempel är 
inställd på två timmar utlöses alarmet BS-NU två timmar innan 
kalibreringen måste göras.

Ketontest  Ketoner är en avfallsprodukt som produceras när kroppen 
tvingas att förbränna kroppsfett i stället för blodsocker för att få 
energi. Det kan vara ett tecken på insulinbrist i kroppen. Ketontestet 
mäter ketonkoncentrationen i blodet eller urinen.

KH  Kolhydrater

Kolh. kvot (Kolhydratkvot)  Den mängd kolhydrater som täcks av en 
enhet insulin. (Se även utbyteskvot).

Kolhydratenheter  Matintag med Bolusguide. Förs in som (kolhydrat) 
gram eller utbyten.

Korrektionsbolus  Den mängd insulin som behövs för att få ned den 
höga blodsockernivån till målvärdet.

Korrektionsbolusfaktor (känslighetsfaktor)  Hur mycket 1,0 enhet 
insulin sänker blodsockret. Denna faktor används för att beräkna en 
korrektionsbolusmängd när blodsockret är högt.
(BS-nivå) – (BS-mål) = X. 
X ÷ (korrektionsbolusfaktor) = 
korrektionsbolus

L
Ljudbolus  Pumpen kan programmeras så att användarna hör en 
signal när de väljer en bolusinsulinmängd (t.ex. 0,5 eller 1,0 enheter) 
som ska doseras. Den här funktionen är praktisk i lägen där det är 
svårt att se knapparna på pumpen.
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Ljudbolus™  Doseringsmetod för en normal bolus som använder Easy 
bolus-knappen på pumpen.

Länk  Att sätta på och koppla upp mätarfunktionen, som gör att 
pumpen kan ta emot BS-värden från CONTOUR® LINK, OneTouch®

UltraLink™ eller Paradigm Link®-mätare.

Termen används även i det här systemet som hänvisning till 
hypertextlänkar. Om du klickar på en hypertextlänk kommer du till 
ett annat ställe i systemet eller till en annan hemsida.

Lågt BS  Pumpen utlöser ett alarm om sensorn indikerar att 
användarens sensorblodsocker är lika med eller under detta värde. Du 
kan aktivera eller inaktivera den här funktionen som du vill.

M
Manuell bolus  Valfritt alternativ i BOLUSMENYN när bolusguiden är 
aktiv. En metod för att programmera en bolus utan bolusguiden. 

Max basalinsulin  Den maximala mängd basalinsulin som pumpen är 
inställd på att dosera per timme. (ställs in av användaren)

Max bolus  Den maximala mängd bolusinsulin som pumpen är inställd 
på att dosera per timme. (ställs in av användaren)

l  Mikroliter  
Mätaralternativ  Funktion som gör att pumpen tar emot BS-värden 
från en länkad blodsockermätare.

Mätare  Ett medicinskt instrument som avgör det ungefärliga 
blodsockervärdet i blodet. En liten droppe blod läggs på en 
testremsa, som mätaren sedan läser av och använder för att beräkna 
blodsockervärdet. Mätaren visar sedan värdet i mg/dl eller mmol/l. 

Måltidsbolus  En dos insulin som doseras för att täcka den förväntade 
höjningen av blodsockret efter en måltid.

N
Normal bolus  En omedelbar dosering av en specificerad mängd 
insulin. 

P
Program A/B  Basalprogram som används vid aktiviteter som inte hör 
till dina dagliga rutiner men ändå ingår i din normala livsstil. Det kan 
till exempel vara en idrott som du utövar en gång i veckan eller en 
förändring av dina sovvanor under veckoslutet, längre perioder med 
högre eller lägre aktivitet, eller menstruation.
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R
RF  Radiofrekvens (RF) 

S
Standardprogram  Din normala basaldos för dina dagliga aktiviteter. 
När programfunktionen är avstängd, använder pumpen ditt 
standard(basal)program.

Steg  Inställd insulinökning per knapptryckning vid Easy Bolus-
dosering.

Stoppa  En funktion hos pumpen som stoppar all insulindosering. Alla 
pågående bolus- och/eller primedoser avbryts. Basaldoseringen 
avbryts temporärt tills den återstartas. 

Sändar-ID   Serienummer på den sändare som för tillfället används.

T
Temporär basal  Temporär dosering av basalinsulin av engångstyp 
med en specificerad mängd och varaktighet. Används för att fylla 
insulinbehov för speciella aktiviteter och situationer som inte tillhör 
de normala, dagliga rutinerna.

Temp  Temporär

U
Utbyteskvot  Den mängd insulin som behövs för att täcka ett (1) 
kolhydratutbyte. (Se även kolhydratkvot).

V
Varning för låg reservoarvolym  Programmerbar varning, som 
antingen uppmärksammar dig på att ett specificerat antal enheter 
finns kvar i pumpreservoaren eller att en specificerad tid återstår 
innan reservoaren är tom.

Ö
Överföra  Processen att föra över uppgifter från pumpen eller 
mätaren till CareLink™ Personals server.
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lägga till enheter
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B
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Medtronic MiniMed produkter 5
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pumpar 5
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med CareLink Pro 3

Bruksanvisning
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skrivsätt 6

C
CareLink Personal

hämta uppgifter 29
länka till ett konto 26
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mejla inbjudan 28

CareLink Pro
alternativ på huvudmenyn 12
Hjälpfunktion 13

aktivera 14
Learn More-länkar 14
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statusfält 9
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ComLink 5, 34
Com-Station 5, 34
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D
Daily Detail-rapport

om 54
Databas
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systemet inte tillgängligt 59
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58
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E
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USB 33
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ComLink 34
Com-Station 34

kablar
seriella 33
USB 33

mätaralternativ 34
översikt 32
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kontrollera uppgifter för 

rapporter 47
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pumpar 36
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Pro 3
spara i systemet 41
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F
Funktioner hos CareLink Pro 2

säkerhet 2
Förhandsvisning

rapporter 52

G
Generera rapporter 52

förhandsvisning 52
skriva ut 52
spara 52

Grundläggande CareLink Pro-uppgifter 
16

Guardian-monitor
lägga till i systemet 36
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H
Hjälp 3
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Kopiera databasen för säkerhetskopia 
58
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L
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om 54
Lägg till en enhet till systemet 36
Lägg till en mätare till systemet 39
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M
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Medtronic MiniMed produkter
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MiniMed hwmsida 3
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alternativa mätare att välja bland 
5
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anslutning till din dator 32

datoranslutningar
seriella 33
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N
Navigering

arbetsområden 10
Navigering i CareLink Pros gränssnitt 9
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